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PCM510xEVM-U

The PCM510x family of ICs are advanced segment, high-performance, hardware-programmable stereo
digital-to-analog converters (DACs). These devices employ internal line drivers together with an internal
PLL and BCLK reference, so that a serial clock signal (SCK) can be derived. The advanced segment
architecture enables excellent dynamic performance and improved tolerance to clock jitter, and the 2.1-
VRMS ground-centered outputs eliminate the need for output dc blocking capacitors. The PCM510xEVM-U
is designed to support the PCM5100, PCM5101, and PCM5102 DACs. The PCM510xEVM-U also
employs the TAS1020B USB controller and the SRC4392 asynchronous sample rate converter.

This user’s guide describes the operation of the PCM510xEVM-U and the Texas Instruments
CodecControl software. CodecControl provides a graphical user interface for supported TI audio codecs.
The software is compatible with Microsoft® Windows® XP, Vista, and Windows 7.
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1 Introduction

CodecControl software is intended to facilitate user evaluation of TI audio codecs. It includes a wide range
of features, depending on the specific codec capabilities. The PCM510xEVM-U works together with the
CodecControl software. It connects to a PC via an available USB port and enumerates as a USB-class
audio device. Once configured with the CodecControl software, the EVM acts as a sound card that can
play back audio from the PC, depending on how the device is set up.

For a more detailed description of the PCM510x product line, refer to the product data sheet available
from the Texas Instruments web site at http://www.ti.com/.

Throughout this document, the abbreviation EVM and the term evaluation module are synonymous with
the PCM510xEVM-U. Unless otherwise noted, all references to the PCM510x indicate complete
functionality of all three related devices (PCM5100, PCM5101, and PCM5102).

1.1 Information About Cautions and Warnings

This document contains caution statements.

CAUTION

This is an example of a caution statement. A caution statement describes a
situation that could potentially damage your software or equipment.

The information in a caution or a warning is provided for your protection. Please read each caution and
warning carefully.

1.2 Related Documentation from Texas Instruments

The following document provides information regarding Texas Instruments integrated circuits used in the
assembly of the PCM510xEVM-U. These documents are available from the TI web site. The last character
of the literature number corresponds to the document revision that is current at the time of the writing of
this document. Newer revisions may be available from the TI web site at http://www.ti.com/.

Data Sheet Literature Number

PCM510x SLAS766

TAS1020B SLES025A

SRC4392 SBFS029C

1.3 Applications Questions

If you have questions regarding either the use of this evaluation module or other Texas Instruments
evaluation modules, post a question in the Audio Converters forum at http://e2e.ti.com. Include in the
subject heading the product in which you are interested.

1.4 FCC Warning

This equipment is intended for use in a laboratory test environment only. It generates, uses, and can
radiate radio frequency energy and has not been tested for compliance with the limits of computing
devices pursuant to subpart J of part 15 of FCC rules, which are designed to provide reasonable
protection against radio frequency interference. Operation of this equipment in other environments may
cause interference with radio communications, in which case the user at his own expense is required to
take whatever measures may be required to correct this interference.
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2 PCM510xEVM-U

2.1 Electrostatic Discharge Warning

Many of the components on the PCM510xEVM-U are susceptible to damage by electrostatic discharge
(ESD). Customers are advised to observe proper ESD handling precautions when unpacking and handling
the EVM, including the use of a grounded wrist strap at an approved ESD workstation.

CAUTION

Failure to observe ESD handling procedures may result in damage to EVM
components.

2.2 Overview

The PCM510xEVM-U is an easy to use, USB-interface, multi-functional system allowing for digital
optical/SPDIF, line or external I2S™ input with varying options for clock sources and clock frequencies.
Along with onboard sample rate conversion, this architecture allows for versatile use and testing of the
PCM510x family of parts. Figure 1 shows the PCM510xEVM-U with the jumper and switch locations
noted.

(1) The silkscreen label shown on the board may be different to indicate a specific device. Otherwise, the EVM is
identical to the one shown here.

Figure 1. PCM510xEVM-U
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It should be noted that the PCM510xEVM-U is divided into two sections. The left half contains the digital
and USB interface, sample rate conversion, optical/SPDIF and RCA digital inputs, clock circuitry, and
reset logic. The right half contains the PCM510x device and the analog circuitry accompanying it. Note
that this half of the PCM510xEVM-U is the portion required on a potential customer application. The left
half is intended to emulate a wide variety of testing options and scenarios for the PCM510x device.

It should also be noted that the digital interface section, or left half of the PCM510xEVM-U, is a four-layer
design. However, the PCM510x device and analog circuitry, or right half of the EVM board, consists only
of two layers.

For the analog circuitry surrounding the PCM510x device, certain components can be removed at the cost
of higher performance. This configurability may allow for optimal ratio between board space and
performance. Components such as C1, C3, C7, and C11 can all be removed for additional board space.

The PCM510xEVM-U features:

• USB Interface

• Analog output

• TX output (J5)

• Optical/SPDIF input

• I2S input

• Hardware- and software-programmable options

• Digital audio interface test points

• Control interface test points

2.3 EVM Block Diagram

Figure 2 shows the block diagram for the PCM510xEVM-U.

Figure 2. PCM510xEVM-U Block Diagram
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2.4 Jumpers, Connectors, Test Points, Switches

Table 1 summarizes the connectors, test points, jumpers, and switches on the PCM510xEVM-U.

Table 1. PCM510xEVM-U Headers, Test Points, Jumpers, and Switches

Connectors/Switch/Jumper/Test Point Description

Headers

W1 I2C/SPI Selection. Shunt Pins 1-2 for SPI, 2-3 for I2C Control
Mode (do not care for PCM510x)

W2 I2C/SPI Selection. Shunt Pins 1-2 for SPI, 2-3 for I2C Control
Mode (do not care for PCM510x)

W3 Interface Connection. Shunt respective headers to send digital
signals to PCM510x.

W4 AVDD Power. Shunt pins 1-2 or 3-4 for AVDD.

W5 MCLK/RXCKO Select

Test Points

TP1 GPIO4/GPIO4/MAST (do not care for PCM510x)

TP2 GPIO5/GPIO5/ATT0 (do not care for PCM510x)

TP3 MC/SCL/ATT1 (do not care for PCM510x)

TP4 MOSI/SDA/ATT2 (do not care for PCM510x)

TP5 GPIO3/GPIO3/AGNS (do not care for PCM510x)

TP6 GPIO2/ADR2/DOUT (do not care for PCM510x)

TP7 MODE1 (do not care for PCM510x)

TP8 MS/MODE2/MODE2 (do not care for PCM510x)

TP9 FLT

TP10 SCK

TP11 BCK

TP12 DIN

TP13 LRCK

TP14 FMT

TP15 XSMT

TP16 PCM510x Analog Output (R)

TP17 PCM510x Analog Output (L)

TP18 1.8 V

TP19 3.3 V

TP20 3.3 VA

TP21 GND

TP22 GND

TP23 GND

TP24 AGND

TP25 AGND

TP26 AGND

TP27 BCLK (TAS1020B)

TP28 WCLK (TAS1020B)

TP29 DIN (TAS1020B)

TP30 SCL (TAS1020B)

TP31 SDA(TAS1020B)

TP32 RESET

Jumpers

J1 PCM510x RCA Analog Output (R)

J2 PCM510x RCA Analog Output (L)

J3 Mini-USB Connection
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Table 1. PCM510xEVM-U Headers, Test Points, Jumpers, and
Switches (continued)

Connectors/Switch/Jumper/Test Point Description

J4 Optical S/PDIF Input

J5 Coaxial S/PDIF Input

J6 BNC External MCLK Input

Switches

SW1 EVM Reset

SW2 Select EVM Application

SW3 MCLK Select

LEDs

D2 RX Lock

D3 SRC Ready

2.5 Clock Circuitry

SW3 allows for MCLK selection from multiple sources. The PCM510xEVM-U contains an external BNC
jack, J6, as well as one programmed oscillator that provides a clock frequency of 24.576 MHz. The
TAS1020B also provides a MCLK output; by default, this clock is used as the master clock for the
PCM510xEVM-U. Depending on the application requirements, the SRC4392 is also able to derive a
received clock output (RCKO) output based on the input clock frequency, and this derived clock output
can be used as the MCLK input for the PCM510x as well. This option is enabled by setting a shunt in
position 1-2 (RXCKO) on the 3-pin jumper W5. If W5 has a shunt in position 2-3, then setting SW3
determines which MCLK source is used, as summarized in Table 2.

Table 2. SW3 Clock Selection

Setting A B C

Onboard MCLK from Low Low LowTAS1020B

External MCLK 3.3-V High Low LowBNC Input

24.576-MHz MCLK from High High HighPLL Y3

2.5.1 MCLK Source Matching

The SRC4392 is equipped with two audio serial data ports, each of which generates BCLK and LRCLK
signals. When the SRC4392 receives an S/PDIF input, it automatically derives the MCLK of the input,
which is sent to the RXCKO pin. Dividers are used to send the generated BLCK and LRCLK from the
audio ports (if they are in master mode). For certain use cases, the SRC4392 is set up so that these ports
are used. When routing through the audio serial ports on the SRC4392, it is important to use RXCKO as
the master clock source for the PCM510x. In order to ensure proper operation, the master clock source
must be synchronized to the bit and word clock supplied to the PCM510x. Therefore, the master clock
source for the PCM510x must also be replicated from the digital input source, which is why RXCKO must
be chosen. If the master clock source for the PCM510x is the onboard MCLK from the TAS1020B USB
controller, for example, then there is potential for synchronization mismatch between the master clock
supplied to the PCM510x and the bit and word clocks being supplied to the PCM510x. For use cases
routing through the SRC4392 audio serial ports, look to jumper W5 for selecting RXCKO as the master
clock source, as opposed to one of the options chosen by adjusting SW3. The SRC4392 product data
sheet has additional routing information.

The PCM510x devices contain an internal PLL and BCLK reference, so that the MCLK can be generated
internally. When using external I2S input directly into the W3 jumper, a MCLK can be derived form the
BCLK input. Refer to the PCM510x product data sheet for more details.
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2.6 Use Cases

2.6.1 Scripts and Setup

While the PCM510x is only hardware programmable, the CodecControl software is still necessary to
properly configure the PCM510xEVM-U for different use cases, such as USB playback or optical/SPDIF
input to the PCM510x. Most of the I/O routing and clock frequency selection on the PCM510x evaluation
module is performed by the SRC4392. Section 2.6.2 and Section 2.6.3 are two example scripts that adjust
the SRC4392 registers accordingly, as well as set proper jumper configurations.

There are several use cases for which the PCM510xEVM-U can be used. Depending on whether it is USB
playback, or optical/SPDIF input, for example, there may need to be changes made in the scripts and
jumper configuration to accommodate these cases. Likewise, the shunts on header W3 may need to be
installed accordingly. Section 2.6.2 and Section 2.6.3 are some example use cases for the PCM5101 for
USB playback and optical/SPDIF input, respectively.

2.6.2 USB Playback
# The following script is used for playback via USB
# RESET RESET THIS IS MASTER RESET FOR SRC (48kHz)
# Page 0 = DEFAULT for Control
# Write to page 0
w E0 7F 00
# Register 01, Bit 7 = 1 resets to default
d 100
w E0 01 80
# Delay 0.1 sec to allow part to reset
d 100
# Register 01, Bit 7 = 0 for normal operation
w E0 01 00
d 100
# w E0 7F 00
# Register 01, Bit 7 = 1 resets to default

#----- Setup Port A ------#

# 24bit I2S, Master mode, DIR source, at mute
# Divide by 256, MCLK input source
# Unmute Port A Output
# power on port A and B
w E0 01 38
# set up port A as master, 24 bit I2S sourced from port B
w E0 03 19
# select MCLK as source at 256fs
w E0 04 01
# port B slave, 24 bit I2S
w E0 05 01

#----- Setup DIR ------#

#DIR Config 1
# Input source: RX2 - S/PDIF RCA (default)
#w E0 0D 01
# Input source: RX4 - S/PDIF optical, RX_MUX = RX1
w E0 0D 08
#DIR Config 2 - default
w E0 0E 01

#----- Setup DIT -----#

# DIT COnfig 1
# Port A data in, DIv 256
w E0 07 80
# DIT Config 2
# Default is to output to RCA
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# Comment out RCA and uncomment Optical for optical outputs
#Output to RCA
# TX - ON, TX MUTE - ON, Optical disabled
#w E0 08 06
# TX Mute - OFF
#w E0 08 04
#Output to Optical
# TX - OFF, TX MUTE - ON, optical disabled
w E0 08 03
# TX MUTE - OFF
w E0 08 01

#----- PLL Configuration -----#

# Set P=2, J=8, D=0
w E0 0F 22
w E0 10 1B
w E0 11 A3
# GPIO1 Config
# GPIO1 = RCVR non-audio data
w E0 1B 06
# GPIO2 Config
# GPIO2 = RCVR non-valid data
w E0 1C 07
# Power Status
# Disable RCVR (/PDRX) and Port B(/PDPB) power down and enable All Function power down
#w E0 01 14
#w E0 03 29

2.6.3 Optical/SPDIF Input via J4 (48 kHz, RXCKO Master Clock)
# RESET RESET THIS IS MASTER RESET FOR SRC
# SW3 (2-7) turned on, rest turned off
# Page 0 = DEFAULT for Control
# Write to page 0
w E0 7F 00
# Register 01, Bit 7 = 1 resets to default
d 100
w E0 01 80
# Delay 0.1 sec to allow part to reset
d 100
# Register 01, Bit 7 = 0 for normal operation

w E0 01 00
d 100
# w E0 7F 00
# Register 01, Bit 7 = 1 resets to default

#----- Setup Port A ------#

# 24bit I2S, Master mode, DIR source, at mute
# Divide by 256, MCLK input source
w E0 03 69
w E0 04 0B

#----- Setup DIR ------#

#DIR Config 1
# Input source: RX2 - S/PDIF RCA (default)
#w E0 0D 01
# Input source: RX4 - S/PDIF optical, RX_MUX = RX1
w E0 0D 08
#DIR Config 2 - default
w E0 0E 01
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#----- Setup DIT -----#

# DIT COnfig 1
# Port A data in, DIv 256
w E0 07 80
# DIT Config 2
# Default is to output to RCA
# Commment out RCA and uncomment Optical for optical outputs
#Output to RCA
# TX - ON, TX MUTE - ON, Optical disabled
#w E0 08 06
# TX Mute - OFF
#w E0 08 04
#Output to Optical
# TX - OFF, TX MUTE - ON, optical disabled
w E0 08 03
# TX MUTE - OFF
w E0 08 01

#----- PLL Configuration -----#

# Set P=2, J=8, D=0
w E0 0F 22
w E0 10 1B
w E0 11 A3

# GPIO1 Config
# GPIO1 = RCVR non-audio data
w E0 1B 06
# GPIO2 Config
# GPIO2 = RCVR non-valid data
w E0 1C 07

# Power Status
# Disable RCVR (/PDRX) and Port B(/PDPB) power down and enable All Function power down
#w E0 01 14

# Unmute Port A Output
w E0 03 29

# Disable All Function power down (all blocks set by local control)
w E0 01 3F

NOTE: For characteristic performance graphs, refer to the PCM510x data sheet.

3 CodecControl Software

This section explains how to use the CodecControl software together with the PCM510x device. While the
PCM510x is only hardware-programmable, the CodecControl software is required to properly configure the
PCM510xEVM-U for different use cases, such as USB playback or optical/SPDIF input to the device.
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3.1 Control Software

The CodecControl software exposes most of the features of a supported TI audio codec EVM through an
intuitive graphical user interface.

NOTE: Before a PC running Windows can use the TI audio converter EVM as a sound card, the
EVM must be properly configured (sampling rate, audio routing, internal amplifier settings,
etc.) with the CodecControl software. This configuration occurs automatically once an EVM is
detected by the CodecControl software.

Figure 3 illustrates the CodecControl software with the PCM510xEVM-U window as an example of the
CodecControl software in operation.

Figure 3. EVM Software Window
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3.2 Installation

Download the CodecControl software from the PCM510xEVM-U audio codec product folder and launch
the program. The file is a self-extracting archive that is downloaded in a compressed format.

The default target folder is:
C:\Program Files\Texas Instruments\CodecControl

Click the Unzip button to complete the installation. The CodecControl software is now available in the
target folder. The name of the executable is CodecControl.exe.

To launch the CodecControl software, navigate to the target folder and double-click the CodecControl.exe
file.

3.3 Concepts

The CodecControl software presents a block diagram view of a supported TI audio codec EVM, such as
that shown in Figure 3.

The block diagram consists of active objects that respond to user input (for example, switches or
amplifiers with variable gain that show a volume control when a user clicks on the component with a
mouse).

NOTE: Active Objects: Each active object changes color to red if the cursor is placed over the
object. Clicking the object triggers its function.

Some active objects are linked to control register(s) of the particular TI audio codec. The CodecControl
software updates the appropriate register(s) whenever an active object is triggered. If a register that is
linked to an active object is changed through other components (for example, the script interpreter or the
register inspector), the active object changes its state accordingly.

The CodecControl software automatically detects a supported TI audio codec EVM once it is connected to
an available USB port of the PC.

If no TI audio codec EVM is connected to the PC, the control software also supports an EVM simulation
mode, where it is possible to retrieve script commands based on user input within the block diagram.

Simulation mode is only available if no TI audio codec EVM is attached to the PC. Choose File->New
EVM simulation… and select an EVM from the list of supported TI audio codec EVMs.

3.4 Dialogs and Active Objects

The CodecControl software contains several dialog windows that provide access to additional features.
Most dialogs are linked to active objects and are opened by clicking on the active object.

Several dialogs are not linked to active objects and are opened instead using the View menu.

3.4.1 Initialization Script Dialog

The CodecControl software executes an initialization script when a supported TI audio codec is detected.

To show or edit the initialization script, choose View->Init Script… from the main window menu bar.

Click the Run button to run the script again.
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3.4.2 Command Dialog

Open the command dialog (View->Command…) to write, edit, load, save, and run command scripts.
Command scripts are text files that contain commands to communicate with the TI audio codec. The
syntax is described in Section 3.5. The command dialog is shown in Figure 4.

Figure 4. Command Dialog

• The primary area of the command dialog is the command buffer (editable text) which contains the
command script. To run the command script, click the Run button

• The smaller, read-only text area on the right side of the command dialog displays control data read
from the TI audio codec. The Clear button clears the Read Data field.

• The one-line text edit field on the left bottom allows single command execution.

• The Record check box enables recording of commands generated by the control software.
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3.4.3 Register Inspector

The register inspector dialog (View->Register Inspector…) gives access to all registers of the TI audio
codec. The register inspector displays the content of the connected TI audio codec device registers. To
trigger reading the content of one page, click the Refresh button.

• The addr column shows the address of the registers in decimal notation.

• The description column contains a description for each register. If the register has no function
assigned, it is declared Reserved.

• The data columns show the data of each register (one byte). The first data column uses decimal
notation, and the second uses hexadecimal notation. It is possible to change the register value by
clicking into one of the data fields and typing the new value (either decimal or hexadecimal).

• The numbered columns show the register content in binary notation. Read/write bits are shown solid
black or red; read-only bits are gray or dark red. Red numbers represent bits that recently changed. To
change a single writable bit, click on the bit and it will flip.

The coefficients may be used for a specific customer filter implementation. The format is compatible with
the TI audio codec that was detected by the CodecControl software.

NOTE: For the PCM510x, which are hardware programmable only, this feature is not used.

3.4.4 Firmware Update

TI may publish new firmware for TI audio codec EVMs. To program the new firmware to a TI audio codec
EVM, choose File->Update Firmware… and select the new firmware file.

The update process takes a few seconds (there is no progress bar) and is completed once the update
firmware dialog disappears. The EVM must be disconnected and reconnected to finish the firmware
update process.

3.5 Script Syntax

A script is a text file that contains data to send to a device.

Each line in a script file is one command. No provision is made for extending lines beyond one line, except
for the > command. A line is terminated by a carriage return.

The first character of a line is the command. Commands are:

r Read from the serial control bus
w Write to the serial control bus
> Extend repeated write commands
# Comment
I Set interface bus to use
b Break
d Delay
f Wait for Flag

Command: r <address> <register> <length>
<address> is the device address in hexadecimal format. For example, 30 for device address 0x30.
<register> is the register in hexadecimal format that will be read from.
<length> is the number of bytes that will be read from <register> in auto-increment mode.
The result will be displayed in the right-side output window of the command interpreter dialog.

Command: w <address> <register> <data ...>
<address> is the device address in hexadecimal format. For example, 30 for device address 0x30.
<register> is the register in hexadecimal format that will be written to.
<data…> is a sequence of bytes that will be written to the <register> in auto-increment mode. Each
byte is in hexadecimal format.
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Command: > <data ...>
This command continues a write sequence in a new line.
<data…> is a sequence of bytes that will be written in auto-increment mode. Each byte is in
hexadecimal format.

Command: # [optional comment]
This command indicates a comment.

Command: I<interface>
<interface> is i2c for I2C™ or spi for SPI

Command: b[optional comment]
[optional comment] is a string of characters. The command interpreter will show a modal dialog with
the optional comment. Script execution will resume once the dialog is closed.

Command: d<time>
This command suspends script execution by at least <time> milliseconds.

Command: f <address> <register> <mask> [optional timeout]
This commands suspends script execution until the value read from <address> <register> matches
<mask>
<address> is the device address in hexadecimal format. For example, 30 for device address 0x30.
<register> is the register in hexadecimal format that will be read from.
<mask> is a 8-bit binary format mask that is compared with the data from the device. Each bit can be
0, 1, or X.
For example: <mask> = 010XX01X tests, if the data from the device has D7 = 0, D6 = 1, D5 = 0, D4 =
don’t care, D3 = don’t care, D2 = 0, D1 = 1, D0 = don’t care.
[optional timeout] specifies how long (milliseconds) the command interpreter will poll the device if the
data do not match the <mask>
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4 PCM510xEVM-U

4.1 PCM510xEVM-U Schematics

Figure 5 through Figure 7 show the schematics for the PCM5122EVM-U.

Figure 5. PCM510xEVM-U Schematic
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Figure 6. PCM510xEVM-U Power and USB Controller
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Figure 7. PCM510xEVM-U Digital I/O and Source
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4.2 PCM510xEVM-U Bill of Materials

Table 3 is the BOM for the PCM510xEVM-U.

Table 3. PCM510xEVM-U Bill of Materials (1) (2) (3)

Item MFG Part Number MFG QTY Ref Designators Description

1 PCM5102PW TEXAS INSTRUMENTS 1 U1 24-BIT 384KHz AUDIO STEREO DAC w/MINI DSP TSSOP20-PW ROHS

2 TPS73618DBVT TEXAS INSTRUMENTS 1 U2 VOLT REG 1.8V 400MA LDO CAP FREE NMOS SOT23-DBV5 ROHS

3 TPS73633DBVT TEXAS INSTRUMENTS 1 U3 VOLT REG 3.3V 400MA LDO CAP FREE NMOS SOT23-DBV5 ROHS

4 TPS2553DBV TEXAS INSTRUMENTS 1 U4 Adj.,Active High,Pwr-Dist Switch,SOT23-DBV6,ROHS

5 TAS1020BPFB TEXAS INSTRUMENTS 1 U6 USB STREAMING CONTROLLER TQFP48-PFB ROHS

6 SN74LVC138APWR TEXAS INSTRUMENTS 1 U7 3-LINE TO 8-LINE DECODER/DEMULTIPLEXER TSSOP16-PW ROHS

7 SN74LVC1G125DBVR TEXAS INSTRUMENTS 3 U8, U9, U11 SINGLE BUS BUFFER GATE WITH 3-STATE OUTPUT SOT23-DBV5 ROHS

8 SN74LVC2G04DBVR TEXAS INSTRUMENTS 1 U10 DUAL INVERTER GATE SOT23-DBV6 ROHS

9 SRC4392IPFBR BURR-BROWN 1 U12 2 CHAN,ASYNC,SAMPLE RATE CONV W/DIG AUDIO REC/XMTR ROHS

10 24FC512-I/SM MICROCHIP 1 U5 512K (64Kx8) I2C SERIAL EEPROM SOIC8-SM ROHS

11 PLR135/T10 EVERLIGHT ELECTRONICS 1 J4 PHOTOLINK FIBER OPTIC RECEIVER 2.4-5.5V 15MB PCB-RA SHUTTER ROHS

12 SML-LXT0805YW-TR LUMEX OPTO 1 D1 LED, YELLOW 2.0V SMD0805 ROHS

13 SML-LXT0805GW-TR LUMEX OPTO 2 D2, D3 LED, GREEN 2.0V SMD0805 ROHS

14 SIT8002AI-13-33E-6.00000T SITIME 1 Y1 OSCILLATOR SMT 6MHz 3.3V OUT-ENABLE ROHS

15 SM7745HSV-22.5792M PLETRONICS 1 Y2 OSCILLATOR SMT 3.3V SM77H SERIES 22.5792MHz ROHS

16 SM7745HSV-24.576M PLETRONICS 1 Y3 OSCILLATOR SMT 3.3V SM77H SERIES 24.576MHz ROHS

17 EEE1CA100SR PANASONIC 0 C1, C3, C7, C11 CAP SMD ELECT 10ufd 16V 20% VS-B ROHS

18 C2012X7R2A104K TDK 4 C2, C4, C6, C10 CAP SMD0805 CERM 0.1UFD 100V 10% X7R ROHS

19 GCM21BR71E225KA73L MURATA 2 C8, C9 CAP SMD0805 CERM 2.2UFD 25V 10% X7R ROHS

20 GRM188R71H222KA01D MURATA 2 C12, C13 CAP SMD0603 CERM 2200PFD 50V 10% X7R ROHS

21 GRM21BR61C106KE15L MURATA 4 C14, C16, C17, C19 CAP SMD0805 CERM 10UFD 16V 10% X5R ROHS

22 C1608X7R1H104K TDK 20 C15, C18, C20, C22, C25, C28, C30, C31, C32, CAP SMD0603 CERM 0.1UFD 50V 10% X7R ROHS
C33, C35, C36, C37, C41, C43, C44, C46, C47,
C48, C49

23 UKZ1E101MPM NICHICON 1 C21 CAP ALUM ELEC KZ RADIAL 100UFD 50V 20% ROHS

24 GRM2165C1H101JA01D MURATA 1 C23 CAP SMD0805 CERM 100PFD 50V 5% C0G ROHS

25 C1608C0G1H102J TDK CORP. 1 C24 CAP SMD0603 CERM 1000PFD 50V 5% COG ROHS

26 GRM1885C1H470JA01D MURATA 2 C26, C27 CAP SMD0603 CERM 47PFD 50V 5% COG ROHS

27 C1608X7R1C105K TDK 1 C29 CAP SMD0603 CERM 1.0UFD 16V 10% X7R ROHS

28 GRM188R60J106ME47D MURATA 2 C34, C45 CAP SMD0603 CERM 10UFD 6.3V 20% X5R ROHS

29 C2012X5R0J226M TDK 3 C38, C40, C42 CAP SMD0805 CERM 22UFD 6.3V 20% X5R ROHS

30 06031C103JAT2A AVX 1 C39 CAP SMD0603 CERM 0.01UFD 25V 5% X7R ROHS

31 ERJ-3GEYJ103V PANASONIC 9 R0, R3, R4, R5, R16, R17, R20, R21, R22 RESISTOR SMD0603 10K 5% 1/10W ROHS

32 ERJ-3GEYJ471V PANASONIC 2 R1, R2 RESISTOR SMD0603 470 OHMS 5% 1/10W ROHS

(1) These assemblies are ESD sensitive, observe ESD precautions.
(2) These assemblies must be clean and free from flux and all contaminants. Use of no-clean flux is not acceptable.
(3) These assemblies must comply with workmanship standards IPC-A-610 Class 2.
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Table 3. PCM510xEVM-U Bill of Materials (1) (2) (3) (continued)
Item MFG Part Number MFG QTY Ref Designators Description

33 ERJ-3EKF1003V PANASONIC 17 R6, R14, R40, R41, R42, R43, R44, R45, R46, RESISTOR SMD0603 100K OHM 1% THICK FILM 1/10W ROHS
R47, R48, R49, R50, R51, R52, R53, R54

34 ERJ-8GEY0R00V PANASONIC 1 R7 RESISTOR SMD1206 0.0 OHM 5% 1/4W ROHS

35 ERJ-3GEYJ272V PANASONIC 2 R8, R9 RESISTOR SMD0603 2.7K OHMS 5% 1/10W ROHS

36 ERJ-3EKF3091V PANASONIC 1 R10 RESISTOR SMD0603 3.09K OHM 1% THICK FILM 1/10W ROHS

37 ERJ-3EKF1501V PANASONIC 1 R11 RESISTOR SMD0603 1.50K OHM 1% THICK FILM 1/10W ROHS

38 ERJ-3EKF27R4V PANASONIC 2 R12, R13 RESISTOR SMD0603 27.4 OHMS 1% 1/10W ROHS

39 RC0603FR-07649RL YAGEO 1 R15 RESISTOR SMD0603 THICK FILM 649 OHMS 1% 1/10W ROHS

40 ERJ-8ENF10R0 PANASONIC 5 R18, R23, R25, R30, R31 RESISTOR SMT1206 10.0 OHM 1% 1/4W ROHS

41 MCR18EZPF75R0 ROHM SEMICONDUCTOR 2 R19, R24 RESISTOR SMD1206 75 OHMs 1% 1/4W ROHS

42 ERJ-3EKF33R0V PANASONIC 4 R26, R27, R28, R29 RESISTOR SMD0603 33.0 OHMS 1% 1/10W ROHS

43 CRCW060322R1FKEA VISHAY 2 R32, R33 RESISTOR SMD0603 22.1 OHMS 1% 1/10W ROHS

44 ERJ-3GEYJ472V PANASONIC 1 R34 RESISTOR SMD0603 4.7K OHMS 5% 1/10W ROHS

45 RCJ-042 CUI STACK 1 J1 RCA JACK THRU RA-FEMALE RED ROHS

46 RCJ-043 CUI STACK 1 J2 RCA JACK THRU RA-FEMALE WHITE ROHS

47 UX60-MB-5ST HIROSE 1 J3 JACK USB MINIB SMT-RA 5PIN ROHS

48 RCJ-047 CUI STACK 1 J5 RCA JACK THRU RA-FEMALE ORANGE ROHS

49 5227699-2 TYCO ELECTRONICS 1 J6 JACK BNC SQUARE 50 OHMS ROHS

50 PBC03SAAN SULLINS 3 W1, W2, W5 HEADER THRU MALE 3 PIN 100LS 120 TAIL GOLD ROHS

51 PBC15DAAN SULLINS 1 W3 HEADER THRU MALE 2X15 100LS 120 TAIL GOLD ROHS

52 PBC02DAAN SULLINS 1 W4 HEADER THRU MALE 2X2 PIN 100LS 120 TAIL GOLD ROHS

53 5002 KEYSTONE ELECTRONICS 23 TP1, TP2, TP3, TP4, TP5, TP6, TP7, TP8, TP9, PC TESTPOINT, WHITE, ROHS
TP10, TP11, TP12, TP13, TP14, TP15, TP16,
TP17, TP27, TP28, TP29, TP30, TP31, TP32

54 5000 KEYSTONE ELECTRONICS 3 TP18, TP19, TP20 PC TESTPOINT, RED, ROHS

55 5011 KEYSTONE ELECTRONICS 6 TP21, TP22, TP23, TP24, TP25, TP26 PC TESTPOINT BLACK 063 HOLE ROHS

56 EVQ-5PN04K PANASONIC 2 SW1, SW2 SWITCH MOM 240G SMD 6x3.5MM ROHS

57 TDA04H0SB1 CK COMPONENTS 1 SW3 SWITCH SMT DIP8 4POS ROHS

58 95947A018 MCMASTER-CARR 4 STANDOFFS STANDOFF M3x25mm 4.5mm DIA HEX ALUM F-F ROHS

59 92148A150 MCMASTER-CARR 4 STANDOFF WASHERS WASHER SPLIT-LOCK M3 6.2mm OD 0.7mm THICK STAINLESS STEEL ROHS

60 92000A118 MCMASTER-CARR 4 STANDOFF SCREWS SCREW M3x8 PHILIPS PANHEAD STAINLESS STEEL ROHS

61 969102-0000-DA 3M 4 W1(2-3), W2(2-3), W4(1-2), W5(1-2) SHUNT BLACK AU FLASH 0.100LS OPEN TOP ROHS

62 969102-0000-DA 3M 12 W3: 1-2, 3-4, 5-6, 7-8, 9-10, 15-16, 17-18, 19-20, SHUNT BLACK AU FLASH 0.100LS OPEN TOP ROHS
21-22, 23-24, 25-26, 29-30

TOTAL 186

X1 DO NOT POPULATE 4 C1, C3, C7, C11
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IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, enhancements, improvements and other
changes to its semiconductor products and services per JESD46, latest issue, and to discontinue any product or service per JESD48, latest
issue. Buyers should obtain the latest relevant information before placing orders and should verify that such information is current and
complete. All semiconductor products (also referred to herein as “components”) are sold subject to TI’s terms and conditions of sale
supplied at the time of order acknowledgment.

TI warrants performance of its components to the specifications applicable at the time of sale, in accordance with the warranty in TI’s terms
and conditions of sale of semiconductor products. Testing and other quality control techniques are used to the extent TI deems necessary
to support this warranty. Except where mandated by applicable law, testing of all parameters of each component is not necessarily
performed.

TI assumes no liability for applications assistance or the design of Buyers’ products. Buyers are responsible for their products and
applications using TI components. To minimize the risks associated with Buyers’ products and applications, Buyers should provide
adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or
other intellectual property right relating to any combination, machine, or process in which TI components or services are used. Information
published by TI regarding third-party products or services does not constitute a license to use such products or services or a warranty or
endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual property of the
third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of significant portions of TI information in TI data books or data sheets is permissible only if reproduction is without alteration
and is accompanied by all associated warranties, conditions, limitations, and notices. TI is not responsible or liable for such altered
documentation. Information of third parties may be subject to additional restrictions.

Resale of TI components or services with statements different from or beyond the parameters stated by TI for that component or service
voids all express and any implied warranties for the associated TI component or service and is an unfair and deceptive business practice.
TI is not responsible or liable for any such statements.

Buyer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements
concerning its products, and any use of TI components in its applications, notwithstanding any applications-related information or support
that may be provided by TI. Buyer represents and agrees that it has all the necessary expertise to create and implement safeguards which
anticipate dangerous consequences of failures, monitor failures and their consequences, lessen the likelihood of failures that might cause
harm and take appropriate remedial actions. Buyer will fully indemnify TI and its representatives against any damages arising out of the use
of any TI components in safety-critical applications.

In some cases, TI components may be promoted specifically to facilitate safety-related applications. With such components, TI’s goal is to
help enable customers to design and create their own end-product solutions that meet applicable functional safety standards and
requirements. Nonetheless, such components are subject to these terms.

No TI components are authorized for use in FDA Class III (or similar life-critical medical equipment) unless authorized officers of the parties
have executed a special agreement specifically governing such use.

Only those TI components which TI has specifically designated as military grade or “enhanced plastic” are designed and intended for use in
military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components
which have not been so designated is solely at the Buyer's risk, and that Buyer is solely responsible for compliance with all legal and
regulatory requirements in connection with such use.

TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of
non-designated products, TI will not be responsible for any failure to meet ISO/TS16949.

Products Applications

Audio www.ti.com/audio Automotive and Transportation www.ti.com/automotive

Amplifiers amplifier.ti.com Communications and Telecom www.ti.com/communications

Data Converters dataconverter.ti.com Computers and Peripherals www.ti.com/computers

DLP® Products www.dlp.com Consumer Electronics www.ti.com/consumer-apps

DSP dsp.ti.com Energy and Lighting www.ti.com/energy

Clocks and Timers www.ti.com/clocks Industrial www.ti.com/industrial

Interface interface.ti.com Medical www.ti.com/medical

Logic logic.ti.com Security www.ti.com/security

Power Mgmt power.ti.com Space, Avionics and Defense www.ti.com/space-avionics-defense

Microcontrollers microcontroller.ti.com Video and Imaging www.ti.com/video

RFID www.ti-rfid.com

OMAP Applications Processors www.ti.com/omap TI E2E Community e2e.ti.com

Wireless Connectivity www.ti.com/wirelessconnectivity
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